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1. Introduction

1.1. QuCoa in a Nutshell

The QuCoa software package is an integrated solution for data acquisition and analysis using PicoQuant's
TCSPC electronics. It is mainly targeted at all research areas that rely on coincidence detection such as
Hanbury-Brown-Twiss setups to study single photon sources (g(2) / antibunching), quantum key distributions
(QKD), or the study of entanglement using Hong-Ou Mandel setups, to name only a few. 

Of pivotal importance are the Time–Tagged Time–Resolved (TTTR) measurement mode (and especially the
T2  time tagging mode)  of  the  MultiHarp  150,  TimeHarp 260,  PicoHarp 300 and HydraHarp 400 TCSPC
devices, which allow the performance of vastly different measurement tasks based on one single data format,
yet  without any sacrifice of information available from each single photon. The T2 data of all  supported
sources are stored in the same PicoQuant Unified Tag File Format, which allows all measurement data to be
handled in a standardised yet flexible way.

Based on the powerful T2 data collection and by application of STUPSLANG, our underlying scripting engine,
users can perform an unlimited number of analysis steps without losing track of the interdependence and
origin of their measurement and analysis data. Results can be obtained through a set of analysis tools, such
as intensity time trace, coincidence analysis, antibunching.

All trademarks mentioned in this manual are the property of their respective owners. PicoQuant claims no
rights to any such trademarks used here. They are used here only for identification or explanation and to the
owner’s benefit, without intent to infringe.
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2. Getting Started

2.1. Requirements

The QuCoa software is suitable for PCs running the Windows 7 x64, 8 x64 or 10 x64 OS. It  demands a
reasonable performance of the PC. For routine work, a machine with x64 quad–core CPU, incl. SSE2 and
Intel 64 or AMD64 extension with at least 2.2 GHz CPU clock and a minimum of 4 GB RAM is necessary. For
improved performance in data acquisition or during complex analysis tasks a CPU with more cores and more
RAM (e.g. 16 GB) is recommended.

The software takes approximately 100 MB, however, not including the storage space for data files. To use the
software efficiently, a full HD screen resolution is needed. For daily work,  a screen resolution of at least
1680 × 1050 pixels is recommended. Even better is a dual display set–up.

The QuCoa package is protected by a HASP protection module (dongle) that must be connected to the USB
port of the PC during operation. In order to recognize its presence and to use the HASP protection module, a
software driver is automatically installed with the QuCoa software package.

2.2. Feature Overview

Data Acquisition Features

TCSPC–Based PicoHarp 300 by import or direct measurement
HydraHarp 400 by import or direct measurement
TimeHarp 260 by import or direct measurement
MultiHarp 150 by import or direct measurement

Suppported numbers of 
detectors

1 to 16

Supported number of 
markers for coincidence 
counting

up to 4 

Measurement modes Antibunching, Coincidence correlation, Coincidence counting 

Measurement previews Coincidence correlation trace (g(2) / Antibunching), Coincidence counting, 
Intensity time trace, TCSPC histogram
Parallel calculation and display of up to 4 different previews 

Analysis Features

General Features Binning
Least–Squares Fitting, MLE fitting, Bootstrap error analysis
GUI themes 

Coincidence correlation Antibunching curve calculation
pulsed excitation: estimation of pulse rate, G(0) and G(∞)
cw excitation: estimation of G(0) and G(∞)

Antibunching Fitting
Global Analysis
Reconvolution with Gaussian
Confidence Intervall Estimation
Model for cw-excitation with and without shelving state
Model for pulsed excitaton, single lifetime parameter

Coincidence counting freely definable coincidence criterion, combination of detection channels and 
markers using logical filters (AND, OR, NOT) in a user-defined time gate

2.3. Installation Procedure

The software is supplied pre–installed and on DVD, together with a copy protection module (HASP). On the
installation DVD you will find the following files and directories:
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QuCoa_Setup.exe self–extracting installation file
Readme.txt installation notes
WhatsNew.txt QuCoa change history
LSM_Remote_Control Remote Control setup and developer documentation
Samples.sptw Workspace with example data
Developer Developer information for QuCoa

 FileDemos Demos for implementing reading of ptu files
HASP drivers for hardware protection module

Install the software by running QuCoa_Setup.exe and follow the instructions of the installer program. The
drivers for the TCSPC electronics can be found on its respective Install DVD or CD and need to be installed
as a part of installing the TCSPC device.  The QuCoa software does not install any drivers, except the
drivers for the HASP copy protection module.

Disclaimer

PicoQuant GmbH  disclaims  all  warranties  with  regard  to  this  software  and  associated  documentation
including all implied warranties of merchantability and fitness. In no case shall PicoQuant GmbH be liable for
any direct, indirect or consequential damages or any material or immaterial damages whatsoever resulting
from loss of data, time or profits arising from use or performance of this software.

PicoQuant GmbH has checked the code and design of this software with regard to potential conflicts with
intellectual property of third parties to the best of knowledge at the time of release, including the particulars of
designated countries of distribution. PQ DOES NOT HOWEVER GUARANTEE FREEDOM OF ANY AND
ALL IP RIGHTS OF THIRD PARTIES.

The country of designation of any individual software license is defined by the first buyer's address according
to  the  original  purchase  documents.  The  user  of  this  software  is  not  permitted  to  circumvent  technical
measures  of  copy  protection  and  functionality  restrictions  implemented  for  compliance  with  intellectual
property rights in the country of designation. The user of the software takes full responsibility for any such
tampering, including modifications he or she applies to the original software, be it binary or source code, that
may lead to infringement of intellectual property rights. The user takes full responsibility for using the software
in a region other than that of designation and any resulting damage due to non-compliance with intellectual
property laws. Second hand buyers take the same responsibilities and are advised not to use the software
without checking possible legal restrictions in their country or region.

License and Copyright Notice

With this product you have purchased a license to use the QuCoa software. You have not purchased any
other rights to the software itself. The software is protected by copyright and intellectual property laws. You
may not distribute the software to third parties or reverse engineer, decompile or disassemble the software or
part thereof. Copyright of this manual and on–line documentation belongs to PicoQuant GmbH. No parts of it
may be reproduced, translated or transferred to third parties without written permission of PicoQuant GmbH.

QuCoa,  SymPhoTime 64,  STUPSLANG,  MultiHarp,  TimeHarp,  PicoHarp  and  HydraHarp  are  registered
trademarks of PicoQuant GmbH. Other products and corporate names appearing in this manual may or may
not be registered trademarks or subject to copyrights of their respective owners. PicoQuant GmbH claims no
rights to any such trademarks. They are used here only for identification or explanation and to the owner’s
benefit, without intent to infringe.
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3. Quick Start Guide
This section aims to provide a short primer on how to carry out an antibunching or coincidence correlation
measurement and analyze the collected data with the QuCoa software package. All steps will be only briefly
outlined here. Detailed explanations of concepts and options can be found in the QuCoa on-line help, which
can be accessed from the Help menu or by pressing the F1 key.

This guide assumes that the QuCoa software is installed and its associated hardware (one TCSPC unit such
as a TimeHarp 260, PicoHarp 300, or HydraHarp 400 as well as up to 8 single photon sensitive detectors)
has been integrated into the experimental set-up.

3.1. Setting the System up for a Measurement

• Turn on and initialize your experimental set up; including the TCSPC unit and all detectors.

• Insert your sample and ensure that the desired feature is located in the observation spot.

• Start the QuCoa software.

• From the main menu bar ( ) select Settings → Hardware Settings:

◦ Check that the QuCoa software has established a connection with the TCSPC unit. If more than
one TCSPC unit is present, the right one can be selected from the  TCSPC selection box and
pressing the Init TCSPC button.

• In the QuCoa software, open or create a workspace (File → Create Workspace or  File → Open
Workspace).

3.2. Optimizing parameters

• Click on the “Test” tab in the CuQoa main window to enter the Test working mode ( ).

NOTE:  While in Test working mode, no data will be saved. The tools available in this mode are intended for
measurement set-up and instrument adjustment.
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• Adjust the settings of the CFD, the Zero Cross and the Delays of the TCSPC Module in the “TCSPC
Settings” panel (if necessary)

• Select the desired online preview panel (e.g.,  Time Trace to monitor and adjust the detector count
rate or  TCSPC Histogram to check usage of histogramming channels). Please note that only one
preview panel can be active at any time in Test working mode.

• Once all parameters have been adjusted to your linking, switch to  Measurement working mode by
clicking on the “Measurement” tab in the CuQoa main window.

3.3. Starting the measurement

• Once in the Measurement working mode, enter a sample name in the text box labeled “Name” under
the Info tab ( ).

• You can optionally enter an extended sample description in the large text box below.

• In tab Point Recording Parameters, you can enable a time limit for the measurement by ticking the
“Stop after” check box and set the duration by means of the spin box next to it ( ).

• Tick the “Discard TTTR Data” check box, if you do not wish to save any raw data ( ).
NOTE: For longer measurements, e.g., 20 min or more, the raw data file can become quite large (in
the order of several GB). By discarding the raw data, only the results of the online analysis will be
saved. Please note that without raw T2 data, the offline analysis will not be possible!

• NOTE: the resolution settings in the “TCSPC Settings” panel will not have any influence on your
data. It only has an influence in the Test mode during histogramming.

• Choose the number of parallel online analysis procedures using the icons on the lower right (  ). Up
to 4 parallel operating analysis procedures are possible. 

• For each on-line analysis select  the desired experiment type (Antibunching or  Coincidence or
Time-Trace) from the drop down box in the top right corner of the main window ( ).

• Set-up the counting conditions for your experiment:

◦ In the case of an Antibunching experiment, select the two channels to be cross-correlated by
ticking their corresponding check boxes in the right part of the main window ( ). The selected
boxes will turn green and display a check mark to indicate that they have been selected. Then
define the maximum time for the correlation and the sampling points. In most cases, these can
also be left at their default values-

◦ In Coincidence mode, the activity pattern for a coincidence can be defined as a logical combina-
tion of detector and maker signals. The combination is set-up by ticking the desired detector or
marker check boxes in the grid shown in the right part of the GUI ( ). 

▪ The time interval  in  which the defined coincidence  pattern  needs to  occur  (so that  it  is
counted as a coincidence) can be set by the spin box “Time Window”

▪ If more than one box is checked in a row, the corresponding detectors / markers will be com-
bined by the boolean operator OR.

▪ Clicking the check box in front of a row will change the logical combination from AND (green
box with check mark) to AND NOT (red box with exclamation mark).

▪ Activating the check box of a row will also add a new empty row to the table.

▪ Detector channels that are not displayed (usually channels > 6) can be access by moving the
mouse cursor the right edge of the grid. The grid will then scroll to show these channels.

▪ At least two detectors need to be active to define an activity pattern.

▪ The boolean expression of the defined activity pattern is shown at the bottom of the grid. A
verbose definition is displayed when hovering the mouse cursor over the boolean expres-
sion.

◦ In CountRate Display up to two intensity time traces can be displayed. These either directly dis-
play one selected input channel or the sum of all channels.
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• The measurement can now be started by pressing the “Start” button above the Info tab ( ).

• Stopping the measurement can be achieved by pressing the “Stop” ( ) button or it will stop auto-
matically if a stop time has been defined.

• During the measurement, the pre-defined online-analysis procedures will be calculated and automati-
cally updated.

3.4. Data Analysis

• Data analysis can be performed either online (in Test and Measurement working mode) or offline (by
opening a saved TTTR data file).

• In the online mode, all data from activated analyses are written to the hard drive. Up to four online
previews can be running simultaneously.

• To perform an offline analysis, select the saved TTTR data from the workspace and then click on the
Analysis ( ) tab in the main window.

◦ Select the desired analysis method from either the Time Trace, TCSPC, Antibunching or Coin-
cidence tab.

◦ Refer to the online help of the software for additional details on the fitting procedures

◦ Results of the analysis can be saved or exported by clicking the the corresponding buttons in the
File tab.
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4. Technical Data / Specifications

Data Acquisition

TCSPC devices:

for direct measurements............PicoHarp 300, HydraHarp 400, TimeHarp 260, or MultiHarp 150

Supported number of detectors ..........1 to 16

Supported number of markers ............up to 4

          for coincidence counting 

Measurement modes:

for direct measurements............TTTR: t2, (test measurements: t3)

Measurement previews .......................Coincidence correlation trace (g(2) / Antibunching), Coincidence 
............................................................counting, Intensity time trace, TCSPC histogram
............................................................Parallel calculation and display of up to 4 different previews 

Analysis

Supported methods.............................Antibunching, coincidence, intensity time traces, lifetime fitting

TCSPC Fitting

Models.................................................1 to 5 exponentials, iterative re-convolution

Optimization.........................................least squares, MLE, Marquardt-Levenberg, Monte Carlo,

............................................................Global analysis

Error test / assessment........................2, distribution weighted residuals

Error analysis......................................Bootstrap

Coincidence Correlation Fitting

Models.................................................cw-excitation with and without shelving state, 

............................................................pulsed excitation with lifetime parameter

Optimization.........................................least squares, Marquardt-Levenberg, Monte Carlo,

............................................................Global analysis

Error test / assessment........................2, distribution weighted residuals

Error analysis......................................Bootstrap

Coincidence Counting

Correlation scheme.............................Combination of detection channels and markers using logical filters  
............................................................(AND, OR, NOT) in user-defined time gates 

User Interface

Graphical user interface.......................Windows™ GUI, menu or mouse driven, STUPSLANG scripted

Preferences.........................................saved in factory / user settings data files

Supported Data Formats

Input for analyzes................................ptu and pqres files: PicoQuant Unified Tag File Format

Output..................................................pqres files: PicoQuant Unified Tag File Format; ASCII file export

Operating Environment

PC requirements:

CPU...........................................with SSE2 and EMT64 or AMD64 extension;

..................................................quad-core or better recommended
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CPU clock..................................minimum 2.2 GHz; recommended ≥ 3 GHz

RAM..........................................minimum 4 GB; recommended: ≥ 16 GB

Disk space.................................≥ 100 MB (program without data storage)

Display(s)..................................Single display: 1920 x 1080 pixel (full HD)

..................................................Dual display: 2 x 1680 x 1050 or higher

Operating System................................64bit Windows™ 7/8/10

Protection module / port.......................HASP USB dongle

Retraction of Old Devices

Waste electrical products must not be disposed of with household waste. This equipment 
should be taken to your local recycling center for safe treatment.
WEEE–Reg.–No. DE 96457402
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5. Support

5.1. Returning Products for Repair

Should you encounter serious problems that require sending the device in for inspection / repair,  please
contact us first at: support@picoquant.com and request an RMA number before shipping the device. Observe
precautions against static discharge under all circumstances during handling, packaging and shipping. Use
original or equally protective packaging material. Inappropriate packaging voids any warranty.
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6. Legal Terms

6.1. Disclaimer

PicoQuant  GmbH  disclaims  all  warranties  with  regard  to  this  software  and  associated  documentation
including all implied warranties of merchantability and fitness. In no case shall PicoQuant GmbH be liable for
any direct, indirect or consequential damages or any material or immaterial damages whatsoever resulting
from loss of data, time or profits arising from use or performance of this software.

PicoQuant GmbH has checked the code and design of this software with regard to potential conflicts with
intellectual property of third parties to the best of knowledge at the time of release, including the particulars of
designated countries of distribution. PQ DOES NOT HOWEVER GUARANTEE FREEDOM OF ANY AND
ALL IP RIGHTS OF THIRD PARTIES.

The country of designation of any individual software license is defined by the first buyer's address according
to  the  original  purchase  documents.  The  user  of  this  software  is  not  permitted  to  circumvent  technical
measures  of  copy  protection  and  functionality  restrictions  implemented  for  compliance  with  intellectual
property rights in the country of designation. The user of the software takes full responsibility for any such
tampering, including modifications he or she applies to the original software, be it binary or source code, that
may lead to infringement of intellectual property rights. The user takes full responsibility for using the software
in a region other than that of designation and any resulting damage due to non-compliance with intellectual
property laws. Second hand buyers take the same responsibilities and are advised not to use the software
without checking possible legal restrictions in their country or region.

6.2. License

With this product you have purchased a license to use the QuCoa software. You have not purchased any
other rights to the software itself. The software is protected by copyright and intellectual property laws. You
may not distribute the software to third parties or reverse engineer, decompile or disassemble the software or
part thereof. Copyright of this manual and on–line documentation belongs to PicoQuant GmbH. No parts of it
may be reproduced, translated or transferred to third parties without written permission of PicoQuant GmbH.

QuCoa, SymPhoTime 64, STUPSLANG, TimeHarp, PicoHarp and HydraHarp are registered trademarks of
PicoQuant  GmbH.  Other  products  and corporate  names appearing  in  this  manual  may  or  may  not  be
registered trademarks or subject to copyrights of their respective owners. PicoQuant GmbH claims no rights
to any such trademarks. They are used here only for identification or explanation and to the owner’s benefit,
without intent to infringe.

6.3. Copyright

Copyright of this manual and on-line documentation belongs to PicoQuant GmbH.  No parts of it may be
reproduced, translated, or transferred to third parties without written permission of PicoQuant

6.4. Trademarks

Other products and corporate names appearing in this manual may or may not be registered trademarks or
subject to copyrights of their respective owners. PicoQuant GmbH claims no rights to any such trademarks.
They are used here only for the purposes of identification or explanation and to the owner’s benefit, without
intent to infringe.
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7. Further Reading

7.1. PicoQuant Bibliography

PicoQuant  maintains  a  database  of  publications  mentioning PicoQuant  devices.  It  can  be found at  our
website  www.picoquant.com/scientific/references. It  is  a valuable source if  you would like to know which
laboratories are using PicoQuant products or how broad the field of various applications is.

7.2. Download of Technical Notes / Application Notes

PicoQuant, along with our customers, continuously writes and publishes short documents about techniques,
methods and applications that are possible with our hardware or software. The download section can be
found at www.picoquant.com/scientific/technical-and-application-notes

7.3. Recommended Literature

Photon Counting D. V. O'Connor,   D. Phillips:
Time–Correlated Single Photon Counting
Academic Press, London, 1984; ISBN 0-12-524140-2 

P. Kapusta:
Photon Counting with PicoQuant Devices Using Low Repetition Rate 
Excitation
Application Note, PicoQuant, 2006

M. Wahl:
Time Tagged Time–Resolved fluorescence data collection
Application Note, PicoQuant, 2004

Various Data 
Analysis Methods

A. Grinwald,   I. Z. Steinberg:
On the Analysis of the Fluorescence Decay Kinetics by the Method of Least–
Squares
Analytical Biochemistry, 1974, Vol. 59, p. 583-598

Fitting Parameter 
Precision

D. E. Koppel:
Statistical accuracy in fluorescence correlation spectroscopy
Physical Review A, 1974, 10, (6), 1938-1945

T. Wohland,   R. Rigler,   H. Vogel:
The standard deviation in fluorescence correlation spectroscopy
Biophysical Journal, 2001, 80, (6), 2987-2999

S. Saffarian,   E. L. Elson:
Statistical Analysis of Fluorescence Correlation Spectroscopy:
The Standard Deviation and Bias
Biophysical Journal, 2003, 84, (3), 2030-2042

Correlation 
Algorithms

S. Chopra,   L. Mandel:
An electronic correlator for photoelectric correlation measurements
Review of Scientific Instruments, 1972, 43, (2), 1489-1491

D. Magatti,   F. Ferri:
Multi–τ real–time software correlator for dynamic light scattering
Applied Optics, 2001, 40, (24), 4011-4021

D. Magatti,   F. Ferri:
25 ns software correlator for photon and fluorescence correlation 
spectroscopy
Review of Scientific Instruments, 2003, 74, (2), 1135-1144

Page 12

http://www.picoquant.com/scientific/technical-and-application-notes
http://www.picoquant.com/scientific/references


PicoQuant GmbH QuCoa v1.2

8. Appendix

8.1. Abbreviations

BNC British Naval Connector or Bayonet Nut Connector or Bayonet Neill Concelman

CAN Controller Area Network

CCD Charge–Coupled Device

CFD Constant Fraction Discriminator

cps Counts per Second

FIFO First In, First Out (buffer type)

FWHM Full–Width at Half–Maximum

IO Input / Output

IRF Instrument Response Function

LED Light Emitting Diode

PC Personal Computer

PCI Peripheral Component Interconnect

PIE Pulsed Interleaved Excitation

PMT Photomultiplier Tube

SMA Sub–Miniature version A (connector type)

SMD Single Molecule Detection

SPAD Single Photon Avalanche Diode

STUPSLANG SymPhoTime User Programming Script LANGuage 

SYNC Synchronisation (signal)

TCSPC Time–Correlated Single Photon Counting

TTL Transistor–Transistor Logic

TTTR Time–Tagged Time–Resolved
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All information given here is reliable to our best knowledge. However, no responsibility is assumed for possible inaccuracies
or omissions. Specifications and external appearances are subject to change without notice.

PicoQuant GmbH
Rudower Chaussee 29 (IGZ)
12489 Berlin
Germany

P +49-(0)30-1208820-0
F +49-(0)30-1208820-90
info@picoquant.com
www.picoquant.com
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